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ПОЯСНИТЕЛЬНАЯ ЗАПИСКА

При  изучении  дисциплины  «Информационные  технологии»

необходимо  закреплять  полученные  знания  практическими  навыками.

Современные  информационные  технологии  способны  заменить  целые

лаборатории,  мастерские  и  другие  оборудованные  помещения.  Например,

студентам помогут виртуальные машины (Oracle VM VirtualBox, Microsoft

Virtual PC),  программно  имитирующие  работу  отдельного  компьютера,

защищающие реальное оборудование компьютера, позволяющие выполнять

функции  администратора,  а  также  различного  рода  офисное  программное

обеспечение (Microsoft Office, Apache  OpenOffice), графические редакторы

(PaintNET, Inkscape).

В данном пособии предложены работы, направленные на закрепление

дидактического  материала  и  приобретение  навыков  в  сфере

информационных  технологий.  Выполняя  задания  и  решая  задачи,

обучающиеся могут проверять знания и правильность своих рассуждений по

рассмотренным темам. 

Лабораторные  работы  предназначены  для  усвоения  материала

теоретических занятий, изучения средств форматирования и редактирования

текстовых  документов,  создания  баз  данных,  работы  с  электронными

таблицами, средств компьютерной графики.

Выполнение лабораторной работы включает этапы:

1. Сбор данных и выполнение списка действий согласно инструкции.

2. Оформление отчета.

3. Защита лабораторной работы.

Сбор данных.

Инструкция по выполнению работы включает следующие разделы: №

лабораторной работы, название, цель, оборудование, порядок выполнения.

Сбор данных выполняется в следующем порядке:

 изучается инструкция по выполнению работы;

 уясняется цель работы и последовательность действий;

 уточняются у преподавателя непонятные моменты;

 подготавливаются необходимые таблицы;



 выполняются действия согласно пунктам раздела «Ход работы».

Основные действия и выводы конспектируются.

Данные конспектируются и затем заносятся в отчет в соответствии с п.2.

Оформление отчета.

Отчет  оформляется  индивидуально  каждым  студентом  на  листах

формата А4.

Отчет по каждой работе должен включать разделы:

1. № лабораторной работы (см. инструкцию по выполнению работ);

2. Название работы (см. инструкцию по выполнению работ);

3. Цель работы (см. инструкцию по выполнению работ);

4.  Ход  работы  (упорядоченное  изложение  хода  выполнения  работы,

выводы и данные по пунктам, заполненные таблицы).

 Защита лабораторной работы.

Для защиты лабораторной работы студент должен:

 изучить  практический  и  теоретический  материал  согласно

вопросам к защите;

 представить результат выполнения работы;

 предъявить полный отчет о проделанной работе;

 ответить  на  вопросы  к  защите  и  дополнительные  вопросы  по

данной теме.

Отчет  защищенной  лабораторной  работы  подписывается

преподавателем с указанием даты защиты работы.

Выполненные  в  полном  объеме  лабораторные  работы  являются

допуском к зачету. Студенты, не защитившие всех лабораторных работ,

к зачету не допускаются!



Тематическое планирование лабораторных работ соответсвенно
календарно-тематическому плану

Название лабораторной работы Количество
часов

Лабораторная работа №1. Создание текстового документа. 
Шрифтовое оформление и форматирование

2

Лабораторная работа №2. Применение редактора формул. 
Создание таблицы 

2

Лабораторная работа №3. Создание вычисляемых ячеек в MS
Word

2

Лабораторная работа №4. Технология создания стиля, 
макроса и формы

2

Лабораторная работа №5. Использование шаблонов и 
электронных форм для сбора информации

2

Лабораторная работа №6. Создание электронной таблицы, 
управление элементами таблицы

2

Лабораторная работа №7. Работа с табличными функциями 2

Лабораторная работа №8. Создание электронных 
презентаций

2

Лабораторная работа №9 -10 Работа с растровой графикой 4

Лабораторная работа №11 -12 Работа с векторной графикой 4

Всего: 0
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Лабораторная работа №1 

Создание текстового документа. Шрифтовое оформление и
форматирование

Цель: закрепить знания по теме, формировать навык набора, редактирования, 
форматирования текста

Методические рекомендации
Внимательно  ознакомьтесь  с  методическими  указаниями  для  выполнения

лабораторной работы

Выполните практическую часть лабораторной работы (два листа): наберите
текст, отформатируйте его по образцу:

-Отобразите непечатаемые знаки (пиктограмма).
-Следите, чтобы между словами был только один пробел.
-Следите, чтобы не было расстояние между абзацами изменялось только при

помощи использования команды Формат-Абзац-Интервал перед (после).
-  Расстояние  между  буквами  слова  можно изменить  с  помощью команды

Формат-Шрифт-Интервал-Интервал-Обычный (Разреженный, Уплотненный).
- Новую страницу можно начать нажатием клавиш CTRL+ENTER.
Вставьте в колонтитул большую рамку, для этого предварительно откройте

файл Рамка_большая.doc, выберите команду Вид-Колонтитулы, выделите рамку
и скопируйте ее. Перейдите на документ, который вы создали, выберите команду
Вид-Колонтитулы  и  вставьте  рисунок,  откорректируйте  его  размещение  на
листе.

Добавьте  в  рамку  с  помощью  команды  Надпись  из  панели  Рисование
соответствующий текст (чтобы не было рамки текстового поля в контекстном
меню выберите команду Формат надписи-Линии-Нет линий):

-в поле Разраб. – свою фамилию и инициалы;
-в поле Руковод. – фамилию и инициалы преподавателя;
-заполните поля Дата, Лист, Листов;
-в верхнее справа поле вставьте текст 09.03.02  .№ зачетки.№ по списку;
-в среднее поле – текст Лабораторная работа № 1;
-сгруппируйте весь рисунок.
Покажите работу преподавателю
Составьте  отчет  о  проделанной  работе,  где  кратко  укажите

последовательность вашей работы
Ответьте на контрольные вопросы (они находятся в конце работы)
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Контрольные вопросы

1. Цифровое представление символьной информации, таблицы КОИ-

8,ASCII, Unicode

2. Классификация текстовых редакторов

3. Интерфейс текстового процессора MS Word

4. Шрифты, их характеристики, виды

5. Определение колонтитула
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Лабораторная работа №2 

Применение редактора формул. Создание таблицы

Цель: научиться рисовать таблицу, вставлять ее в документ, работать со 
списками, вставлять колонтитулы, диаграммы.

Методические рекомендации
Вы можете создать в своих документах маркированные, нумерованные

и многоуровневые списки. Для этого Word вставляет в документы маркеры
или  нумерацию  с  нужными  отступами.  Маркированные  и  нумерованные
списки создаются с помощью панели инструментов форматирования или в
окне диалога Список (команда Формат -Список).

Для  создания  списков  с  помощью  панели  инструментов
форматирования нужно сделать следующее:

 Введите  список.  Нажимайте  Enter  в  конце  каждого  элемента,
чтобы он содержался в отдельном абзаце.
 Выделите все абзацы списка.

 Щелкните  кнопку  Маркеры   или  Нумерация   на  панели
инструментов  Форматирование,  чтобы  оформить  выделенные
абзацы в список соответствующего типа.

Чтобы убрать маркеры или нумерацию, следует выделить абзацы и снова
щелкнуть  кнопку  Маркеры или  Нумерация.  Кроме  того,  можно удалить
маркер или нумерацию только в одном абзаце. Для этого следует установить
курсор сразу после маркера или номера и нажать клавишу Backspase.

Примеры списков:

Нумерованный Маркированный Многоуровневый

1. декабрь
2. январь
3. февраль
4. март
5. апрель
6. май

 декабрь
 январь
 февраль
 март
 апрель
 май

 Зима
 Декабрь
 Январь
 Февраль

 Весна
 Март
 Апрель
 май

Диалоговое  окно  Список по  сравнению  с  кнопками  панели
форматирования  предоставляет  пользователю  ряд  дополнительных
возможностей по изменению формата создаваемого списка.  Например, для
пометки  элементов  маркированного  списка  можно  выбрать  более
привлекательные отметки, чем жирные точки. Выбор знака для выделения
элементов списка осуществляется следующим образом:
выделить  весь  список,  затем  щелкнуть  правой  кнопкой  на  выделенном
списке,  чтобы раскрыть контекстное меню. Затем выбрать  Список,  чтобы
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вызвать диалоговое окно Список (рис.1)  и щелкнуть на кнопке Изменить.
(Диалоговое окно Список можно также вызвать командой Формат-Список)
 в  появившемся  диалоговом  окне  Изменение  маркированного  списка

щелкнуть на кнопке Маркер.
 выбрать желаемый знак из диалогового окна Символ.
 установить  подходящий  размер,  цвет  и  положение  отметки,  если  это

необходимо.
 щелкнуть на кнопке ОК.

Для  создания  многоуровневых  списков  нужно  использовать  кнопки

Увеличить отступ  и Уменьшить отступ   на панели инструментов
«Форматирование».  Для  того,  чтобы  организовать  второй  (третий  и  т.д.)
уровни  списка  сначала  нажимают  клавишу  Увеличить  отступ,  затем
набирают элементы списка (можно сначала сделать одноуровневый список, а
затем  выделить  части,  относящиеся  к  следующему  уровню  и  нажать
Увеличить  отступ).  Для  изменения  формата  многоуровневого  списка
используют  команду  Формат-Список,  вкладку  Многоуровневый.  В
появившемся  окне  для  изменения  параметров  списка  нужно  щелкнуть  по
кнопке Изменить. В результате появится окно Изменение многоуровневого
списка.  Для  изменения  вида  маркера  нужно  в  поле  Нумерация выбрать
желаемый символ  из  раскрывающего  списка,  или  выбрать  опцию  Новый
маркер, если нужного маркера в данном списке нет.

Покажите выполненную работу преподавателю и узнайте вариант  
дополнительного задания.
Ответьте на контрольные вопросы (см ниже)
Оформите отчёт, сделайте вывод о проделанной работе.

Контрольные вопросы
1. Для чего используются нумерованные и маркированные списки в 

тексте?

2. При помощи каких кнопок на панели Форматирование можно 
создавать маркированные и нумерованные списки?

3. Какие кнопки на панели Форматирование используются для создания 
многоуровневых списков?

4. Опишите возможности, предоставляемые пользователю в диалоговом 
окне Список?

5. Как создать список, не используя кнопки на панели инструментов 
Форматирование? 

6. Опишите, каким образом можно поменять пометку элементов 
маркированного списка.
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Лабораторная работа №3

Создание вычисляемых ячеек в MS Word
Цель: отрабатывать навык создания вычисляемых ячеек в MS Word

Методические рекомендации

Создание стендового документа

Первым  шагом  работы  будет  создание  «стендового»  документа,  который  мы  будем
использовать при написании и отладке макроса.

Для этого сделайте следующее:

 Запустите Word.
 Наберите сами или скопируйте откуда-нибудь любой текст.

Пусть, для простоты, в нем не будет ни картинок, ни таблиц, никаких других сложных
элементов.

Например, так:

Только не открывайте уже существующий документ!  Мы будет создавать макрос «с
нуля», кроме того, это упростит работу.Теперь несколько участков надо определить как
имеющие стиль примечание.

Сначала надо создать стиль примечание (в предопределенном наборе Word этого стиля
нет), относящийся к символам текста, а не к абзацам – ведь мы будем преобразовывать в
сноски  слова,  а  не  абзацы.  Если  же  вы  пожелаете  создавать  примечания  именно  из
абзацев, то сможете самостоятельно записать макрос, используя знания, полученные при
обучении.Заметим  сразу,  что  название  стиля  не  несет  никакой  смысловой  нагрузки,
можно применить любое другое слово – лишь бы название не совпадало ни с каким из
имеющихся. Кроме того, в последующей работе вы должны помнить, что это название
стиля уже используется.

Для создания нового стиля:

Поместите  курсор в  тексте,  который будет иметь  новый стиль.  В нашем «стендовом»
тексте подразумевается фраза «примечание…».

 Сделайте это:
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 Поместите курсор (щелкните один раз мышкой) на слове «примечание» в 
созданном вами тексте.

 Выполните команду меню Формат Стиль…

Здесь и далее  будет применяться  система краткого описания команд меню программы
Office.  Вышеуказанная запись обозначает,  что вам следует щелкнуть один раз в строке
меню на пункте «Формат», а затем на появившемся меню на пункте «Стиль…»:

В результате выполнения команды меню появится окно:

Как видите, в этом окне и происходит работа со стилями.

 Щелкните кнопкуСоздать…

Везде в подобных случаях указания относятся к окну, с которым идет работа.  То есть
здесь имеется в виду щелчок по кнопкеСоздать… окна работы со стилями, которое вы
только что вызвали.

Появится окно создания стиля:

 В поле Имя:, вместо имени Стиль1 (на рисунке эта надпись выделена) введите 
примечание.

 Рядом, в падающем списке Стиль выберите значение Знака:

Это делается для того, чтобы стиль применялся к словам, а не к целым абзацам.
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Для наглядности изменим внешний вид нового стиля.

 Щелкните кнопку Формат.
 В появившемся меню выберите пункт Шрифт.

Появится окно настройки шрифтов.

 В списке Начертание выберите пункт Полужирный:

 Щелкните ОК.

Окно настройки шрифтов исчезнет.

 Еще раз OK.

Вы вернетесь в окно создания стилей.

 ЩелкнитеПрименить.

Теперь вы можете оформить текст.

 Переместите курсор (одиночным щелчком мыши) в начало будущей сноски:

Для выделения текста быстрее и проще (особенно тем, кто не вполне уверенно владеет
мышью)  использовать  клавиши.Описание  сочетаний  клавиш,  применяемых  для
перемещения курсора и выделения символов и слов текста, вы сможете найти в справке
MS Word.

 Дважды нажмите [Ctrl]+[Shift]+[ ].

Это сочетание приводит к выделению слова (или пробела) слева от курсора.

Текст должен приобрести такой вид:

Теперь примените созданный стиль к выделенному тексту.

 Для этого на панели инструментов Word найдите падающий список, содержащий 
все доступные в данном документе стили:

 И в этом списке выберите пункт с названием нового стиля.
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Появится окно справки Word.

 Выберите вкладку Мастер ответов
 В полеВыберите действие: введите слово стиль.
 Нажмите [Enter]

Появится список разделов справки, так или иначе относящихся к макросам (слева внизу):

 Например, попробуйте произвести поиск по фразеСоздать стиль.

Как видите, список результатов изменился.

Присвойте документу имя, по которому вы легко поймете предназначение документа,
например: макрос_word_1. При сохранении позаботьтесь, чтобы документ был размещен
в месте, где вы его легко найдете. Рекомендуется создать специальную папку, в которой
вы будете хранить файлы, создаваемые в процессе обучения.

«Стендовый» документ создан.

Проектирование макроса

Программы  MS  Office  обладают  очень  полезной  возможностью  автоматически
создавать макросы. При этом происходит запись последовательности выполнения команд
этой программы MS Office и нажатий на клавиши. Движения мыши не записываются (за
исключением случаев, когда действия мыши приводят к выполнению какой-либо команды
программы MS Office).

Для записи макроса сначала следует определить (спроектировать) последовательность
действий, которую вы хотите записать.

Последовательность  действий  для  преобразования  абзаца  определенного  стиля  в
макрос, очевидно, будет выглядеть так:

 найти текст со стилем примечание и выделить его
 вырезать найденный текст в буфер обмена.

Буфер обмена– специальное средство операционной системы Windows, служащее для
обмена данными между разными программами.
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 создать в месте расположения курсора сноску
 вставить вырезанный ранее текст из буфера обмена в сноску

Эту последовательность можно изобразить наглядно, в виде схемы – так и называемой:
схема последовательности действий:

 найти текст со стилем примечание и выделить его
 вырезать найденный текст в буфер обмена
 создать ПОЧТИ в месте расположения курсора сноску (курсор надо будет немного 

сместить, чтобы сноска выглядела хорошо)
 курсор САМ перейдет в панель сносок
 вставить вырезанный ранее текст из буфера обмена в сноску (то есть ПРОСТО 

вставить текст, вставка всегда происходит в место нахождения курсора, а он уже 
находится в нужном месте)

 из панели сносок перейти обратно в текст

Для  обработки  дальнейшего  текста  потребуется  повторить  эту  последовательность
несколько раз – до конца текста. Как это сделать, мы разберем позднее.

Покажите выполненную работу преподавателю и узнайте вариант  
дополнительного задания.
Ответьте на контрольные вопросы (см ниже)
Оформите отчёт, сделайте вывод о проделанной работе.

Лабораторная работа №4 

Технология создания стиля, макроса и формы
Теоретическая часть

Цель: сформировать навыки работы с текстовым процессором
Ход работы:

Ознакомьтесь  с  теоретической  частью  лабораторной  работы,
законспектируйте в рабочую тетрадь

Выполните  практическую  часть  лабораторной  работы,  опираясь  на
изученную теорию

В  MS  Word  создайте  программу,  позволяющую  заполнять  стандартные
заявления  студентов  учебного  заведения,  если  все  необходимые  данные
заполняются  в  соответствующих  текстовых  полях  формы,  а  причина
пропусков занятий выбирается из раскрывающегося списка.
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Рис. 1. Разработанная форма примера в рабочем состоянии
Последовательность действий:
 cоздайте текстовый документ Word
 откройте редактор кода Visual Basic
 добавьте к вашему документу пользовательскую форму
 на  форму  добавьте  необходимые  элементы:  восемь  Label,  семь

текстовых полей, один ComboBox, две кнопки
 измените надписи на метках и кнопках соответственно рисунку
 откройте редактор кода и пропишите на событие инициализации формы

код для добавления текста к элементу ComboBox

 запустите  приложение,  проверьте,  добавляются  ли  компоненты  для
выбора

 вызовите код для события Click первой кнопки (дважды нажмите на нее)
и пропишите код для вывода заявления

 сначала выведем заголовок с новой строки:

 добавим код для вывода информации о группе

 аналогично  выведите  остальную  информацию  из  меток  и  текстовых
полей. Помните, чтобы текст начинался с новой строки, надо вставлять

код 
 не забудьте вывести слово «Заявление» и слова «Прошу считать пропуск

за», «уважительным по причине:»
 для  вывода  выбранной  информации  из  элемента  ComboBox

используется код 
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 если вам трудно еще сориентироваться в программном коде, то часть его
приведена ниже

 на кнопку Выход добавьте  код для выхода (см.  лабораторную работу
№2)

 назначьте  созданной форме кнопку для ее  запуска (см.  лабораторную
работу №2, задание №4)

 Составьте отчет о проделанной работе, ответив на контрольные вопросы

Контрольные вопросы
1. Что такое форма, какой это объект?
2. Перечислите известные вам свойства объектов UserForm
3. Перечислите известные вам события объектов UserForm
4. Как назначит кнопку для формы на панели быстрого доступа?

Лабораторная работа №5 

Использование шаблонов и электронных форм для сбора информации
Цель: сформировать навыки работы с текстовым процессором

Изучить теоретические сведения
Основными  стилевыми  настройками  редактора   Word  являются

Шаблон Стиль Макрос
Основные понятия
Шаблон -  это  файл,  содержащий настройки Word.  Любой документ

Word создается  на основе некоторого шаблона.  Большинство создается на
основе шаблона Normal.dot, который загружается автоматически, например,
при нажатии кнопки "Создать"  на стандартной панели инструментов.  При
открытии  документа,  основанного  на  некотором  шаблоне,  последний
загружается автоматически. В редакторе Word имеется набор шаблонов для
часто используемых документов. Как правило, эти шаблоны хранятся в папке
MSOffice\Шаблоны.  Однако,  пользователь  может  создавать  и  свои
собственные шаблоны. В шаблоне может храниться следующая информация:

1. стили; 
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2. параметры страницы и бумаги; 
3. обычный текст, таблицы, рисунки; 
4. формы; 
5. макросы; 
6. пользовательские меню; 
7. панели инструментов и другая информация. 

Методы работы с шаблонами
Создание шаблона
1. Выберите  меню  "Файл"  затем  "Создать...".  В  окне  "Создание

документов"  установите  метку  "Шаблон  ",  найдите  и  выделите  шаблон
"Обычный" на основе которого будет создан свой шаблон. Нажмите "Ок". 

2. Установите  требуемые  параметры  форматирования  документа,
введите  тексты  и  другую  информацию,  которую  следует  сохранить  в
шаблоне. 

3. Выберите  меню  "Файл"  затем  "Сохранить  как  ..."  и  папку,  в
которую нужно сохранить шаблон. В поле "Имя файла" введите имя шаблона
и  нажмите  "Ок".  Расширение  .doc  будет  добавлено  к  имени  шаблона
автоматически. 

Загрузка шаблона
Существует два способа загрузки шаблона:
 при  открытии  документа,  основанного  на  некотором  шаблоне,

последний загружается автоматически; 
 при  создании  нового  документа  выберите  меню  "Файл"  затем

"Создать...".  В  окне  "Создание  документа"  установите  метку  "Документ",
найдите и выделите нужный шаблон и нажмите "Ok". 
Задание №1
Создание шаблонов

Установите:
a) параметры страницы: верхнее поле – 3 см, нижнее поле – 5 см, 

левое поле – 3 см, правое поле – 1,5 см.
b) отступ красной строки 2 см;
c) полуторный межстрочный интервал;
d) выравнивание текста по ширине

Добавьте:
a) нумерацию страниц снизу по центру;
b) верхний колонтитул, содержащий имя файла (выравнивание по 

левому краю, размер шрифта 8).
Сохраните файл по именем «ЛР3.doc».
В конце набранного текста добавьте разрыв раздела (начало раздела – со 
следующей страницы);
Скопируйте весь текст из первого раздела во второй.
Повторите эти действия. В результате должно получиться три раздела с 
одинаковым текстом.
Для первого раздела установите:
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a) параметры страницы: верхнее поле – 3 см, нижнее поле – 5 см, 
левое поле – 3 см, правое поле – 1,5 см.

b) отступ красной строки 2 см;
c) полуторный межстрочный интервал;
d) выравнивание текста по ширине
e) добавьте верхний колонтитул, содержащий имя файла 

(выравнивание по левому краю, размер шрифта 8).
Для второго раздела установите: 

a) параметры страницы: верхнее поле – 6 см, нижнее поле – 6 см, 
левое поле – 1 см, правое поле – 1 см, ориентация листа – альбомная

b) двойной межстрочный интервал
c) оформите страницу рамкой, выполните заливку текстом (вид рамки 

и цвет заливки - произвольный)
d) удалите колонтитул

Для третьего раздела установите:
a) параметры страницы: верхнее поле – 10 см, нижнее поле – 5 см, 

левое поле – 3 см, правое поле – 3 см, ориентация листа – книжная;
b) выполните разбиение текста на 2 колонки.
c) добавьте нижний колонтитул, содержащий номер страницы (по 

центру).
Сохраните файл.

Удалить  ненужный  стиль  можно,  выделив  его  в  списке,  и,  нажав
клавишу Delete.

Задание 
Измените стиль в соответствии с одним из предложенных вариантов.

Шрифт – Times New Roman, 14, полужирный, цвет красный, 
приподнятый. Выравнивание – по правому краю.

Стеки сетевых протоколов (Заголовок 1)

Методы работы с формами 
Формой может быть любой документ, содержащий поля. Существует

три типа полей: для ввода текста; флажок; раскрывающийся список. Порядок
вставки  полей  достаточно  прост:  установите  курсор  в  позицию для  ввода
поля формы, обратитесь к меню "Вставка" затем "Поле формы..."и выберите
один  из  трех  типов  полей.  Если  документ  содержит  много  полей  то  для
экономии времени в окне "Поле формы" нажмите кнопку "Панель". В этом
случае  на  экране  будет  присутствовать  панель  "Формы"  с  необходимым
набором инструментов.  В  Word-97  все  операции с  формами выполняются
через  панель  "Формы",  вызываемую  из  меню  "Вид"  затем  "Панели
инструментов...".

Построение формы
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Построение фор мы проходит в 3 этапа:
 Построение структеры формы 
 Втавка инастройка полей формы 
 Защита и сохранение форма 

Покажите  выполненную  работу  преподавателю  и  узнайте  вариант
дополнительного задания.

Оформите отчёт, сделайте вывод о проделанной работе.

Лабораторная работа №6 

Создание электронной таблицы, управление элементами таблицы

Цель: отработать навыки использования различных возможностей 
электронных таблиц.

Задание №1. Составить таблицу, вычисляющую n-й член и сумму 
арифметической прогрессии.

an=a1+d (n−1)   - формула n-го члена   арифметической прогресии
Sn=( a1+an )∗n /2  - формула суммы n первых членов арифметической прогресии,
где a1− первый член прогресии,

      d - разность арифметической прогресии
Ниже представлена  таблица  для  вычисления  n-го  члена  и  суммы  арифметической

прогрессии, первый член которой равен -2, а разность равна 0,725. 

Вычисление n-го члена и суммы
арифметической прогрессии

d n an Sn

0,725 1 -2 -2
0,725 2 -1,275 -3,275
0,725 3 -0,55 -3,825
0,725 4 0,175 -3,65
0,725 5 0,9 -2,75
0,725 6 1,625 -1,125
0,725 7 2,35 1,225
0,725 8 3,075 4,3
0,725 9 3,8 8,1
0,725 10 4,525 12,625
0,725 11 5,25 17,875

1. Выделите диапазон ячеек А1:D1 и объедините их путем нажатия на пиктограмму .
В полученную ячейку введите заголовок таблицы «Вычисление  n-го члена и суммы
арифметической прогрессии».

2. Чтобы  длинное  предложение  помещалось  в  нужной  области,  нужно  установить
функцию «переносить по словам».  Выделите нужную ячейку (или диапазон ячеек),
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нажмите  по  ней  правой  кнопкой  мыши и  выберите  в  контекстном  меню  Формат
ячеек...→ вкладка «Выравнивание» → установить галочку «переносить по словам»
в разделе Отображение. 

3. В ячейку A2 введите «d», в ячейку  B2 — «n», в С2 — « an », в  D2 – « Sn ». Для
набора  нижних  индексов  в  пункте  Видоизменение активизируйте  переключатель
Подстрочный.

4. В ячейку А3 введите величину разности арифметической прогрессии (d).
5. В третьем столбце размещаются n-е члены прогрессии.
6. В ячейку C3 внесите значение первого члена арифметической прогрессии «-2».
7. Все формулы начинаются со знака равенства.   Выделите ячейку С4 и наберите в ней

формулу =С3+А3 (не забудьте перейти на латиницу), нажмите Enter. 
8. Заполните ряд ячеек от  C5 до  C13 «протащив»  маркер заполнения вниз.  Выделите

ячейку С8 и посмотрите в  строке формул, как выглядит формула, она приняла вид
«=С7+А7». 

9. Аналогично  введите  в  ячейку  D3  формулу  =(-2+С3)*В3/2  для  подсчета  суммы  n
первых членов арифметической прогрессии.

10. Выделите ячейку  D3 и заполните формулами нижние ячейки, протащив вниз  маркер
заполнения.

11. В полученной таблице  попробуйте  внести изменения,  например,  измените  разность
арифметической прогрессии на значение 0,31. Что происходит с данными в таблице?

Задание  №2.  Подготовить  традиционную  таблицу  квадратов
двузначных чисел.

ТАБЛИЦА КВАДРАТОВ
  0 1 2 3 4 5 6 7 8 9

1 100 121 144 169 196 225 256 289 324 361
2 400 441 484 529 576 625 676 729 784 841
3 900 961 1024 1089 1156 1225 1296 1369 1444 1521
4 1600 1681 1764 1849 1936 2025 2116 2209 2304 2401
5 2500 2601 2704 2809 2916 3025 3136 3249 3364 3481
6 3600 3721 3844 3969 4096 4225 4356 4489 4624 4761
7 4900 5041 5184 5329 5476 5625 5776 5929 6084 6241
8 6400 6561 6724 6889 7056 7225 7396 7569 7744 7921
9 8100 8281 8464 8649 8836 9025 9216 9409 9604 9801

1. В  ячейку  А3  введите  число  1,  в  ячейку  А4  –  число  2.  Заполните  ячейки  А5-А11
числами от 3 до 9 и диапазон В2:К2 числами от 0 до 9, используя маркер заполнения.

2. Выделите столбцы от А до К и выполните команду  вкладка Главная→ Формат→
Ширина столбца, в поле ввода Ширина столбца введите значение, например, 5.

3. Воспользуемся  Мастером функций.  Для этого выделите ячейку,  в которой должен
разместиться результат вычислений (В3), и выполните команду  вкладка Формулы→
Вставить  функцию. Среди  предложенных  категорий  функций  выберите
Математические,  имя  функции:  Степень,  нажмите  кнопку  OK.  В  следующем
диалоговом окне введите число (основание степени) А3*10+В2 и показатель степени =
2. 

4. Распространите  эту  формулу  и  на  остальные  ячейки  таблицы.  Применяйте
абсолютные  ссылки.  Для  фиксирования  любой  позиции  адреса  ячейки  перед  ней
ставят знак  $.  Таким образом верните  ширину  столбца С в  исходное  положение и
выполните следующие действия.

5. Выделите  ячейку  В3  и,  установив  текстовый  курсор  в  Строку  формул,  исправьте
имеющуюся  формулу  =СТЕПЕНЬ(А3*10+В2;2)  на  правильную
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=СТЕПЕНЬ($А3*10+В$2;2) Теперь, воспользовавшись услугами маркера заполнения,
можно заполнить этой формулой все свободные ячейки таблицы (сначала протянуть
маркер заполнения вправо, затем,  не снимая выделения с полученного блока ячеек,
вниз).

6. Осталось заняться  оформительской работой:  ввести в ячейку А1 название таблицы,
заполните фоном отдельные ячейки.

Покажите выполненную работу преподавателю и узнайте вариант  
дополнительного задания.

Ответьте на контрольные вопросы (см ниже)
Оформите отчёт, сделайте вывод о проделанной работе

Контрольные вопросы
1. Для чего предназначен табличный процессор MS Excel?
2. Что такое ячейка?
3. Как называется документ MS Excel?
4. Что такое диапазон?
5. Что такое маркер заполнения и для чего он применяется?
6. Как осуществляется ввод формулы в MS Excel?

Лабораторная работа №7 

Работа с табличными функциями
Цель  работы: изучение  приемов  работы  с  Мастером  функций,

организации  вычислений  с  массивами  и  оформления  отчета  средствами
Excel. 

Задание
Внимательно ознакомьтесь с теоретической частью лабораторной работы.

В  соответствие  с  вариантом,  соответствующим  номеру  ПК,  найдите

решение  X системы линейных алгебраических уравнений  AX=B,  где  A –

матрица коэффициентов, B – вектор свободных членов тремя способами:

 методом Крамера

 матричным способом и

 с помощью надстройки Поиск решения

Решение СЛАУ
Каждый  способ  решения  оформляйте  на  отдельном  листе,

предварительно  переименовав  его  в  ,  соответственно,  Метод  Крамера,
Матричный метод, Поиск решения.
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Если  первым  символом  текста  в  ячейке  должен  быть  знак  "=",  ввод
следует начинать с апострофа.

Нижние индексы при X задаются через Формат/Ячейки/ Шрифт.
Длинные  текстовые  записи  оформляются  путем  объединения  ячеек  и

использования режимов переноса по словам и вертикального выравнивания
по  центру  через  меню  Формат/  Ячейки/  Выравнивание.  Высоту  ячеек,
содержащих  многострочные  записи,  следует  отрегулировать  протяжкой за
заголовки строк.

Начать новый абзац внутри ячейки можно нажатием Alt+Enter.
Оформите  отчет  по  стандартной  форме.  В  отчет  включите  ответ,
являющийся решением системы линейных алгебраических уравнений
Покажите выполненную работу преподавателю и узнайте вариант  

дополнительного задания.
Ответьте на контрольные вопросы (см ниже)

Контрольные вопросы
1. Что такое табличная функция. Какие табличные функции вам знакомы?
2. В чем отличие ввода табличной и обычной функции Excel?
3. Опишите метод Крамера и его реализацию в Excel
4. Опишите матричный метод решения СЛАУ и его реализацию в Excel
5. Опишите другие, изученные вами в теоретической части лабораторной

работы № 6 методы решения СЛАУ и их реализацию в Excel

Лабораторная работа №8 

Создание электронных презентаций

Цель: Научить пользователя основным принципам и приемам при 

подготовке презентаций

Задание: Подготовить три первых слайда приглашения на занятия астрокосмической 

школы.

Для решения этой задачи выполним следующее:

Запустить программу PowerPoint:  Пуск / Программы / PowerPoint

I. Создание слайдов презентации.
1. В диалоговом окне PowerPoint войти в меню Файл → Создать → из 

открывшегося справа диалогового окна «Создание презентации» щелкнуть по 
вкладке «Из шаблона оформления» и выбрать понравившийся вам дизайн, 
например дизайн «Глобус». 

2. На первом (титульном) слайде щелкните мышью в поле «Заголовок слайда» и 
введите текст: 

Добро пожаловать (Шрифт Arial, размер шрифта 44 п., полужирный, выровнять 
по центру)

в астрокосмическую школу (Шрифт Arial, размер шрифта 36п., полужирный, 
выровнять по центру)

«АРГО»! (Шрифт Arial, размер шрифта 48п., полужирный, выровнять по центру).
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3. Щелкните мышью в поле «Подзаголовок слайда» и введите текст
Жизнь планет, звезд и галактик
Тайны мироздания и поэзия Вселенной

4. С помощью команды Вставка / Надпись введите дополнительный текст внизу 
слайда:

Руководитель – Андрей Фесенко  (Шрифт Times New Roman, размер шрифта 32п., 
полужирный, выровнять по центру, цвет шрифта черный)
Тел. 200-14-18 (Шрифт Times New Roman, размер шрифта 44п., полужирный, 
подчеркнутый, выровнять по центру, заливка надписи бирюзовый цвет).
5. Вставьте в слайд графический объект, выполнив команду  
Вставить / Автофигуры / Звезды и ленты / Пятно2 / цвет заливки автофигуры – 
красный.
6. Сохраните Презентацию в папке Мои документы под именем АРГО.
7. Для создания второго слайда выполните команду: 
Вставка / Создать слайд
8. В диалоговом окне «Создание слайда» выберите автомакет с названием 

«Маркированный список» либо «Заголовок и текст» и ОК.
9. Щелкните мышью в поле «Заголовок слайда» и введите текст: Программа школы.
10. Щелкните мышью в поле «Подзаголовок слайда» и введите маркированный список 

со стандартным маркером: 
 Общая астрономия
 Астрофизика
 Искусство, озаренное звездами…
 Астрофотография…

11. Вставьте в слайд рисунок, выполнив команду:
Вставка/ Рисунок / Картинки / Выбираем клип «Наука и техника» - рисунок 
Астрономия.
12. Для создания третьего слайда выполните команду: Вставка / Создать слайд
13. В диалоговом окне «Создание слайда» выберите автомакет с названием 

«Заголовок, объект и текст» (рисунок слева, текст - справа) и ОК.
14. В поле «Заголовок слайда» введите текст: Астрономия в мировом 

изобразительном искусстве – от каменного века до наших дней (размер шрифта
32п., Ж, выровнять текст по центру). 

15. В поле «Текст слайда» вводим маркированный список, при этом стандартный 
маркер заменим распахнутой книгой, выполнив команду: 

Выделяем фрагмент текста, т.е. наш маркированный список/ Щелкаем правой 
кнопкой мыши / Список / Маркированный / Знак / Выбираем шрифт Wingdings / 
выбираем маркер Книга / ОК / ОК.
 Гольбейн
 Пуссен
 Рубенс … (размер шрифта 44п, Ж)
16. В поле «Вставка картинки» - два щелчка левой кнопкой мыши. В диалоговом окне

выберите подходящий по смыслу рисунок и вставьте его в слайд.

Покажите выполненную работу преподавателю и узнайте вариант  
дополнительного задания.
Оформите отчёт, сделайте вывод о проделанной работе.

Лабораторные работы № 9-10
Работа с растровой графикой

Цель работы: способствовать формированию первичных навыков создания 
изображений в растровом графическом редакторе Paint.NET
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Ход работы
Теоретическая часть

Paint.NET  является  полноценным  графическим  редактором.  Он  обладает  широкими
возможностями  обработки  фотографий.  Большинство  аналогичных  программ  имеют
довольно  высокую  цену,  что  ограничивает  их  доступность.  Paint.NET,  напротив,
бесплатен. Вы можете свободно установить программу и использовать ее неограниченное
количество времени.

Очень удобно работать  со слоями в этой программе,  чем мы с вами и займемся  на
лабораторной работе.

Практическая часть
На сегодняшнем занятии мы с вами будем выполнять различное оформление текста.

Вместо приведенного слова каждый студент должен работать со  своей фамилией или
ником.

Задание 1. Пылающий текст в Paint.Net

1. Для начала,  создайте новый документ и залейте ( )  его черным цветом, назовите
слой Фон.
Проверьте, отображается ли у вас панель слоев (Window-Layers)

2. Создайте новый слой, назовите его Текст  и нанесите на этот слой текст ( ), если
текст не виден, то проверьте, а не совпадает ли цвет текста с цветом фона :).

3.  Выделите  текст  с  помощью  инструмента  "Magic  Wand  (Волшебная  Палочка)"  и
клавиши Ctrl.

4.  Нанесите  на  выделенный  текст  градиент  ( ),  выберите  линейный  градиент( ),
цвета  градиента  подберите  следующим образом:  основной цвет которого  должен быть
оранжевый, а вторичный коричневый. Чтобы градиент наложился на текст, надо провести
мышкой по тексту, удерживая левую кнопку мыши/

5. Теперь сделайте дважды дубликат слоя (CTRL+SHIFT+D) с текстом, и переименуйте
МаленькийТекст и БольшойТекст
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6.  Снимите  выделение  с  текста,  если  он  еще  выделен.  Для  слоя  "  МаленькийТекст  "
примените  "Effects  → Blurs  → Gaussian  Blur  (Эффекты  → Размытие  → Размытие  по
Гауссу)" с радиусом 10, а для слоя " БольшойТекст " с радиусом 80.

7. Объедините слоя с текстом в один слой ( )

8. Создайте новый слой Облака выше слоя с текстом. Примените для нового слоя "Effects 
→ Render → Clouds (Эффекты → Узоры → Облака)", цвет в которых должен черно-
белый:

9. Установите режим для этого слоя – "Color Dodge (Осветление основы)":

10. Для слоя Облака примените "Effects → Distort → Dents (Эффекты → Искажение →
Dents)", с такими параметрами:

(или подберите свои параметры)
Слои объединять не надо. Сохраните файл с расширением .gif

Текст в стиле матрицы
1. Создайте новый документ и залейте его черным цветом (слой Фон).
2. Создайте новый слой и на нем черно-зеленым цвет напишите текст (Текст)
3. Дублируйте слой. Перейдите в " Adjustments → Brightness/Contrast" и оба параметра
поставьте  на  100.  Теперь  текст  должен  быть  белым;  сделайте  слой  невидимым
(БелыйТекст):
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4. Перейдите обратно к слою Текст и примените "Effects → Photo → Glow" и Radius – 20,
Brightness – 90 и Contrast – 60.

5.  Для  слоя  Текст  примените  "Effects  → Blurs  →  True  Blur(или  Gaussian  Blur или
Gaussian Blur+)" – Radius  – на 20. Повторите Glow, но теперь Contrast – 100.
6. Дублируйте текущий слой, назовите его Сейсмограф и примените "Effects → Stylize →
Seismograph" – Line Spacing поставьте 4, Line Width ~ 2.35, Segment Size – 6 и Deflection –
3 (проверьте, чтобы в палитре основной цвет был черным)

7. Слой БелыйТекст сделайте видимым. Для Seismograph слоя в характеристика слоя →
строка Blending Mode ставим Multiply.
8. Для слоя с белым текстом примените "Effects → Distort → Crystalize – Cell Size равно
2, Quality – 5. Примените "Effects → Blurs → Motion Blur", Аngle равно 0, Distance – 5.

9. Для этого же слоя примените "Effects → Noise → Add Noise", параметры: Intensity 40,
Color Saturation 0 и Coverage 100
10. Blending Mode текущего слоя переключите на Reflect. Дублируйте слой БелыйТекст и
Blending Mode переключите на Color Dodge.
11. Выберите Seismograph слой и примените  Add Noise, с параметрами, как и в шаге 9,
только Intensity – 45.
12.  Дублируйте  Glow  слой  (по  порядку  он  должен  быть  вторым  в  списке  слоев),  и
примените "Effects → Distort → Frosted Glass", параметры: Maximum Scatter Radius равно
200, Minimum Scatter Radius – 3 и Smoothness – 8.

13. Для этого слоя примените Effects → Stylize → Halftone", параметры: во вкладка Shape

выберите Line, Size равно 5, Аngle – 0, Contrast – 100, Brightness – 25 and Quality – 5.
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Покажите выполненную работу преподавателю и узнайте вариант  

дополнительного задания.

Ответьте на контрольные вопросы (см ниже)
Оформите отчёт, сделайте вывод о проделанной работе.

Контрольные вопросы
1. Назовите известные вам форматы графических файлов, опишите их.
2. Назовите известные вам цветовые модели, принцип их построения.
3. Что  является  минимальным  объектом,  используемым  в  растровом

графическом редакторе?
4. Каково назначение пиктограмм:

 , , , 

Лабораторные работы № 11-12
Работа с векторной графикой

Цель работы: способствовать формированию первичных навыков создания 
векторных изображений в векторном графическом редакторе Inkscape

Теоретическая часть

Inkscape (Инкскейп) – векторный графический редактор, удобен для создания как
художественных,  так  и  технических  иллюстраций.  Это  стало  возможным  во  многом
благодаря  открытому  формату  SVG,  развиваемому  консорциумом  W3C.  Формат  SVG
позволяет  создавать  иллюстрации  различного  типа,  в  том  числе  анимированные.
Поскольку SVG основан на языке разметки XML, к нему можно писать расширения, чем
авторы Inkscape  и пользуются.  Программа распространяется  на условиях GNU General
Public License.

Практическая часть

Запустите графический редактор Inkscape. 

Изучите меню и инструменты.
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Создайте изображение паука или кельтский орнамент по выбору.

Паук

1. Инструментом «Эллипс» нарисуйте окружность, удерживая Ctrl.

2. Создайте дубликат окружности и уменьшите его, удерживая прижатыми 
клавиши Sift+Ctrl, чтобы сохранить центр и форму.

3. Удалите прямоугольный сегмент из большой окружности одним из способов.
 

Способ №1

Нарисуйте прямоугольник. Выделите его и большой эллипс  (инструментом  
выделите один объект, прижмите клавишу Sift, выделите второй объект). 

 
Нажмите Ctrl+-  или выберите в меню  «Контуры>Разность». Получите 
нижеследующую фигуру.
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Способ №2

Выделите большую окружность, нажмите  F5 и выставьте настройки инструмента
«Эллипс», как показано ниже.

Следующим шагом будет объединение элементов. Выделим оба эллипса и 
нажмем Ctrl++  (или «Контуры>Сумма»).

Не снимая выделения, инструментом  кликните посередине объекта. Вы увидите, что 
направляющие изменили форму, включен режим поворота и искажения. Поворачивайте фигуру
за одну из угловых направляющих (удерживая Ctrl), либо введите в поле «Угол вращения» 45 
градусов.
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Снова кликните по объекту, чтобы вернуть направляющие в первоначальное 
состояние. Скопируйте фигуру, потянув ее немного вниз (для точного смещения 
удерживайте Ctrl).

Выберите оба объекта и нажмите Ctrl+-  или выберите в меню  
«Контуры>Разность».

Залейте фигуру черным

Добавим пауку еще пару ножек. Создайте копию. Переместите немного новый 
объект вверх с помощью стрелок на клавиатуре и «сожмите» его.
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 При желании, вы можете добавить больше ног вашему паучку, а может что-нибудь 
еще:

Кельтский орнамент

Нарисуйте круг средней величины, используя инструмент Ellipse или F5. При этом 
держите нажатым Ctrl, чтобы круг действительно был круглым. Нарисуйте круг меньшей 
величины и разместите его в центре предыдущего. Выделите оба круга и нажмите Ctrl+- 
или выберите в меню  «Контуры>Разность». 

Создайте "лучик". Для этого нарисуйте пером замкнутую кривую с пятью узлами. 
Измените получившийся контур так, чтобы он стал похожим на этот,

 
и залейте его черным цветом.

Дублируйте "лучик",  полученную копию отразите по вертикали и по горизонтали. 
Сгруппируйте эти два "луча" 
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 и создайте несколько копий. Пары можно поворачивать, меняя расстояние между ними
так, чтобы "лучей" было меньше или больше.

 
Создадим тень. Сгруппируйте все "лучики" и кольцо, создайте дубликат орнамента. 

"Тень" поместите на задний план ("Объект>Опустить на задний план" или нажмите 
клавишу End), перед этим не забыв выполнить заливку.
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Задание 3.
Придумайте свой оригинальный орнамент.
Ответьте на контрольные вопросы (см ниже)
Оформите отчёт, сделайте вывод о проделанной работе.

Контрольные вопросы
1. Назовите известные вам форматы графических файлов, опишите их.
2. Назовите известные вам цветовые модели, принцип их построения.
3. В чем состоит принцип построения векторного рисунка?
4. Что  является  минимальным  объектом,  используемым  в  векторном

графическом редакторе?

5. Каково назначение пиктограмм , , ?
6. Как просмотреть историю создания рисунка в векторном графическом 

редакторе Inkscape?



Список использованных источников

Перечень  рекомендуемых  учебных  изданий,  Интернет-ресурсов,
дополнительной литературы

Основные источники

1. Гохберг Г.С. Информационные технологии (10-е изд., стер.) учебник, М.:
Издательский центр «Академия», 2017.

2. Михеева  Е.В.  Информационные  технологии  в  профессиональной
деятельности:  Учеб.  Пособие  для  сред.  проф.  образования  –  М.:
Издательский центр «Академия», 2016.

3. Гвоздева В.  А. Базовые и прикладные информационные технологии.  —
М.: Инфра-М, 2015. 

4. Информационные  системы  и  технологии  под  ред.  Ю.Ф.  Тельнова  –
Юнити-Дана, 2012.

5. Грошев А. Информатика, 2-е изд. — ДМК Пресс, 2015.
6. Михеева  Е.  В.  Практикум  по  информационным  технологиям  в

профессиональной  деятельности:  Учеб.  пособие  для  сред.  проф.
образования. — М.: Издательский центр «Академия», 2013.

7. Таненбаум Э.,  Остин Т.  Архитектура компьютера.  –  6-е  изд-е.  –  СПб.:
Питер, 2016.

8. Левин А. Самоучитель полезных программ. — Спб.: Питер, 2015.
9. Левин А. Самоучитель работы на компьютере. — М.: Нолидж, 2013.

Дополнительные источники

1. Гвоздева,  В.  А.  Информатика,  автоматизированные  информационные
технологии  и  системы:  учебник  /  В.  А.  Гвоздева.  -  М.:  ИД "ФОРУМ-
ИНФРА-М, 2017.

2. Сидоров  В.,  Струмпэ  Н.  Аппаратное  обеспечение  ЭВМ.  —  М.:  ИЦ
«Академия», 2014.

3. Рудаков А.  Технология разработки программных продуктов — М.:  ИЦ
«Академия», 2013.

Интернет-ресурсы

1. http://biznit.ru/ Сайт  о  применении  информационных  технологий  в
различных областях

2. http://www.grafika-online.com/ Векторная и растровая графика
3. http://www.pstut.ru/ Сайт-учебник по компьютерной графике
4. http://ru.wikipedia.org Официальный  сайт  русской  версии  свободной

энциклопедии «Википедия»


	2022 г.
	Тематическое планирование лабораторных работ соответсвенно календарно-тематическому плану
	Лабораторная работа №1
	Лабораторная работа №2
	Лабораторная работа №3
	Создание стендового документа
	Проектирование макроса

	Лабораторная работа №4
	Ход работы:
	Лабораторная работа №5
	Задание

	Лабораторная работа №6
	Лабораторная работа №7
	Задание
	Лабораторная работа №8
	Жизнь планет, звезд и галактик
	Тайны мироздания и поэзия Вселенной
	Вставка / Создать слайд
	Список использованных источников

